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About the Manuals
Included with the Reader is the Quick Start Guide and this 
User’s Guide. Additionally, after installing eBook Library 
software from the supplied CD-ROM, you can refer to the 
Help within eBook Library.

Browsing the User’s Guide

Browsing this Guide on your computer
Click the Start menu in the bottom left of the Desktop, then 
select “All Programs” – “Reader” – “PRS-505 User’s Guide” 
to start Adobe Reader and open the User’s Guide.
For details on how to use Adobe Reader, refer to Adobe 
Reader Help.

Hint
•	 To view the User’s Guide, you should have installed Adobe Reader 

5.0 or later. Adobe Reader can be downloaded for free from the 
Adobe website (www.adobe.com).
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Using the eBook Library Help

Refer to the eBook Library Help for details about using 
eBook Library, such as importing books to your computer 
and transferring them to the Reader.
Follow the steps below to start eBook Library and browse 
Help.

	 Click the Start menu from your computer, then 
select “All Programs” – “Reader” – “eBook Library”.

	 Click “Help” – “eBook Library Help” on the Menu bar.
Help appears.
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Introduction

What You Can Do with Reader
First, read the Quick Start Guide to prepare the Reader for 
use. Initially after purchase, you need to charge the Reader 
battery, and install the dedicated software “eBook Library” 
and the software “Adobe Digital Editions” on your computer.
Once initial preparation is complete, you can transfer 
content from your computer to the Reader to take anywhere 
you wish.

Downloaded 
eBooks*1

*2

*1	 Online eBook store
*2	 Book/Audio/Picture files that you already have

Transferring

Charge the Reader, then install eBook Library 
and Adobe Digital Editions.

Downloaded eBooks from 
eBook store

Transfer content from your 
computer to the Reader 
using eBook Library and 
Adobe Digital Editions.

Enjoy content on the 
Reader.

Reading/
Playing/Viewing

Importing

Getting Started
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Guide to Parts and Controls

Front
	Enter button*1

To decide an item or apply a setting, 
press the Enter button.

	/// buttons*1

To select an item or scroll around the screen, press  
(left),  (up),  (down), or  (right).

*1	 In this manual, the operation of the ////Enter buttons are 
explained as follows.

	 (Example) Press /// to select “Away” on the Book list, then 
press Enter.

Continued

Enter button
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	MENU button
To return to the previous screen or show a menu. (  
page 13)

	  (page) / (>/<) buttons
To turn the page or proceed/return to the next (>)/
previous (<) content. (  page 37, 40, 56, 59)

	Number (1 – 9,0) buttons
To select the numbered items on the screen or input 
numeric values on the Setting menu. (  page 37, 40, 55, 
59)

	SD Memory Card slot
To insert a SD Memory Card (optional). (  page 20)

	 “Memory Stick Duo” slot
To insert a “Memory Stick Duo” (optional). (  page 20)

	POWER switch
To switch on/off the Reader. (  page 15)

	 Indicator
Lights up in red while charging, and goes off when 
charging is complete. (  page 17)
Flashes in orange while the Reader is accessing your 
computer via USB.
Also flashes in orange while switching the Reader on or 
off.

Continued �
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	Holes for soft cover attachment
The soft cover is attached when purchased. (  page 12)

1

2

3

4

5

6

7

8

9

0

Folds open in use

Note
•	 Do not leave the Reader in a high temperature conditions, as it 

may damage the soft cover.

	  (size) button
To zoom in/out a page or picture. (  page 41, 60)

	  (MARK) button
To create/remove a bookmark. (  page 50)

	Hole for hand strap
To attach the hand strap.

	USB connector
To connect the USB cable (supplied). (  page 28)

	DC IN jack
To connect the AC power adapter (optional).

	 Hint
•	 The Reader can be charged by connecting to a computer 

using the supplied USB cable.

Continued 10
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	 (Headphones) jack
To connect headphones (optional). (  page 55)

 VOLUME +/– buttons
To adjust the volume. (  page 57)
To mute the sound, press and hold the VOLUME +/– 
buttons. To restore the sound, press the VOLUME +/– 
buttons again.

Rear

	Reset button
To reset the Reader if no operation is possible. (  page 
72)

Continued 11
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About the serial number
The serial number provided for the Reader is required for 
the customer registration. The number is on the label on the 
rear of the Reader. Do not remove the label.

Removing/attaching the soft cover

1

2

3

4

5

6

7

8

9

0

Removing the soft cover
	Pull the tab of soft cover towards A.
	Remove the Reader in the direction of B.

Attaching the soft cover
	Insert the tab C of the soft cover in the hole D of the 

Reader.
	Pull the tab of the soft cover towards A.
	Insert the Reader in the direction of E to attach it to the 

soft cover.
	Check that the tabs of the soft cover are completely 

inserted in the holes of the Reader.

Note

•	 Note that the tab of the soft cover may become deformed, if you 
pull the tab too strongly.

12
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Basic Operations

Menu Operations
You can switch between screens, read/play/view content, or 
set items, using the ////Enter buttons, number buttons, 
or MENU.
Example: screen transition diagram of the Home menu – 
Book list – Option menu – Book page

Press / to 
select, then 
press Enter.

Press MENU to 
return to the 
previous screen.

Number tab
Selected item is highlighted in black.

Press / to select “Books by Title” then press 
Enter.

Press / to select, 
then press Enter.

If the stored books are more than 30, 
the Index menu appears. (  page 46, 
48)

Continued 13
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Hints
•	 By pressing and holding  (size), screen orientation can be 

switched (vertically/horizontally). (  page 44)
•	 By using the number buttons, corresponding numbered items can 

be selected.
•	 By pressing and holding MENU, the screen can be returned to the 

Home menu.

14
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Turning on Reader
Slide the POWER switch in the direction of  to turn on the 
Reader.

Slide the POWER 
switch.

The Reader turns on.
It may take a few moments to turn on the Reader and the 
start-up screen to appear when used for the first time, after 
a reset or shut down, or when the battery has depleted.
The indicator lights up in orange when the Reader is turned 
on.

To turn off the Reader
Slide the POWER switch in the direction of  again.
The Reader turns off.

Continued 15
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About the Sleep Mode (resume function)
You can set the Reader to automatically enter sleep mode. 
In sleep mode, the Reader automatically turns off if no 
operation is performed for 60 minutes (resume function). 
The previously displayed screen appears when turned on by 
sliding the POWER switch from this state.
The Sleep Mode setting can be configured from the Setting 
menu. (  page 65)

Note

•	 In the following states, the Reader will not automatically turn off, 
even if no operation is performed for 60 minutes.
–	When connected to the computer using the supplied USB cable
–	When connected to the AC Adaptor for Reader (AC-S5220E) 

(optional) to charge
–	When playing audio files

Continued 16
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About charging
Charging the Reader is required when using for the first 
time. Turn on the Reader, and then charge in one of the 
following two ways.
•	 Connect to a computer via USB (Refer to the Quick Start Guide 

and  page 28). 
(Charging time: approx. 4 hours*)

•	 Connect to an AC outlet using the AC power adapter and AC 
power cord (optional). 
(Charging time: approx. 2 hours*)
*	 Approximate time required to fully charge the battery.

Notes

•	 When you connect the Reader to your computer,  (indicating 
connection via USB) is displayed on the Reader’s screen. If the 
battery has been fully depleted, it takes about 40 minutes until  
is displayed, and you will not be able to turn on the Reader by the 
POWER switch during this time. In this case, wait until  is 
displayed. The indicator lights up in red while  is not displayed, 
and the Reader is charged.

•	 If the remaining battery power of a connected notebook computer 
is low, charging via USB connection may not be possible.

•	 If you connect the Reader to a notebook computer which is not 
connected to an AC outlet, the battery of the notebook computer 
will be consumed. Do not leave the Reader connected to a 
notebook computer which is not connected to an AC outlet for an 
extended period.

•	 Connecting the Reader via a USB hub or extension cable may not 
work and is not supported. Connect the USB cable directly to the 
computer.

Continued 17
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You can verify the remaining battery power by checking the 
indicator in the bottom left of the screen. Charge the battery 
when remaining power is low (the fewer black segments 
indicated, the lower the remaining power).

Note

•	 If the remaining battery power is low, the following warning 
appears. Charge the battery.

	

	 If you continue to use without charging, the following warning 
appears, and the Reader will turn off automatically.

	 Charge the Reader and turn it on again.
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Inserting a Memory Card
The following memory cards can be inserted in the Media 
slots of the Reader.

Note

•	 The Reader has separate slots for “Memory Stick Duo” and the SD 
Memory Card. Be sure to insert the memory card in the correct 
slot. Inserting the memory card in the wrong slot may damage the 
slot and the memory card.

“Memory Stick Duo”*1 “Memory Stick Duo” 
“Memory Stick PRO Duo”

SD Memory Card*2 SD Memory Card
SDHC Memory Card
miniSD Card *3

*1	 The Reader does not comply with MagicGate standard, and the data 
requiring the copyright protection function cannot be copied or played 
on the Reader.

*2	 The Reader does not comply with copyright protection of SD Memory 
Cards.

*3	 miniSD Card adaptor (sold separately) required.

Notes

•	 An operation check is performed when using a “Sony Memory Stick 
Duo” of up to 16 GB, however, operation of all “Memory Stick Duo” 
is not guaranteed.

•	 An operation check is performed when using an SD Memory Card 
of up to 16 GB, however, operation of all SD Memory Cards is not 
guaranteed.

•	 When inserting the memory card into the Reader, it may take time 
for the Reader to recognize the content files in the memory card if 
the capacity of the content files stored on the memory card is large.

Continued 19
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Inserting a memory card into the Reader

	 Remove the plastic cards from the “Memory Stick 
Duo” slot and SD Memory Card slot.
The plastic cards are inserted in the “Memory Stick Duo” 
slot and the SD Memory Card slot at purchase. When 
not using the memory card, insert the plastic card into 
the slot.

Note

•	 If the plastic card is not inserted in the slot, foreign objects may 
enter the slot, and cause malfunction or damage.

Continued 20
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	 Insert a memory card in the  direction with its label 
side up until it clicks into the place.

Note

•	 The Reader has separate slots for “Memory Stick Duo” and the 
SD Memory Card. Be sure to insert the memory card in the 
correct slot. Inserting the memory card in the wrong slot may 
damage the slot and the memory card.

  
Mark

“Memory 
Stick Duo”

SD Memory 
Card

  
Mark

Notes

•	 Be sure to insert the memory card in the correct direction. Forced 
insertion may damage the slot.

•	 Do not insert an incompatible memory card, as it may cause 
malfunction.

•	 Do not use a deformed memory card or adaptor.

Continued 21
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Removing a memory card from the Reader

	 Gently push in the memory card.
You will hear a click, and the memory card pops out.

“Memory 
Stick Duo”

SD Memory 
Card

	 Remove the memory card squarely from the 
“Memory Stick Duo” slot or the SD Memory Card 
slot.

Notes

•	 Do not remove a memory card or turn off the Reader while reading 
or writing data, as data may be damaged.

•	 For details on handling memory cards, refer to  page 89.

22
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Importing Content

Importing eBooks from eBook 
Store
You can download eBooks from an online eBook store to 
your computer.

Notes

•	 To download eBooks, you need to prepare an Internet-accessible 
environment on your computer.

•	 You need to authorize eBook Library and the Reader with Adobe 
Digital Editions. Once Adobe Digital Editions is installed and 
authorized, you can download Adobe DRM protected PDF and 
EPUB content using Adobe Digital Editions. You can also read 
them in eBook Library, and transfer them to the Reader.

	 For details about authorizing, refer to the Quick Start Guide.

	 Double-click the eBook Library icon ( ) on 
Windows desktop.

	 Hint
•	 You can also start eBook Library by clicking the Start menu and 

then selecting “All Programs” – “Reader” – “eBook Library”.

	 Click “eBook Store” in the Source view.
The View area is switched to the Store view and the 
eBook Store page appears.

Continued 23



PRS-505.GB.3-277-508-11(1)

	 Follow the page instructions to purchase 
(download).
You can download eBooks using Adobe Digital Editions.

Hints
•	 eBooks can be read on eBook Library using your computer. For 

details on eBook Library operations, refer to the eBook Library 
Help.

•	 eBook Library and the Reader support interoperability with Adobe 
Digital Editions 1.5 or later.

•	 Adobe Digital Editions is a PC-application which supports the 
reading and managing of PDF and EPUB documents, and 
performs the required authorization to the Adobe DRM system.

•	 Once Adobe Digital Editions is installed and authorized, eBook 
Library and the Reader (PRS-505) will be enabled to support the 
Import/Transfer/Reading of Adobe DRM protected PDF and EPUB 
content.

•	 For details about usage or support of Adobe Digital Editions, refer 
to the Adobe information page at the following web site:  
http://www.adobe.com/go/digitaleditions_uk.

24
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Importing Content from Your 
Computer
You can import content files stored on your computer into 
Library of eBook Library.

You can import the following content files.
•	 Book 

PDF file*1, EPUB file*1 Text file, RTF file, Word file (unsecured)*2, 
BBeB Book

•	 Audio 
MP3 and AAC format audio files (unsecured)

–	MP3 file (.mp3 file extension) 
The following specifications should be met in order to import an 
MP3 file. 
Bit rate: 32 to 320 kbps 
Sampling frequency: 22.05, 44.1 kHz

–	AAC file ( .mp4, .m4a, .mov, or .qt file extension) 
The following specifications should be met in order to import an 
AAC file. 
Bit rate: 40 to 320 kbps 
Sampling frequency: 24.0, 44.1, 48.0 kHz

Note
•	 Movie files are not supported.

•	 Picture 
Bitmap file, JPEG file, GIF file, PNG file

*1	Adobe DRM protected PDF and EPUB files supported only if 
Adobe Digital Editions 1.5 or later is installed and authorized on 
your computer. For details on authorizing the Reader for Adobe 
DRM protected content, refer to Adobe Digital Editions Help at:  
http://www.adobe.com/go/digitaleditions_help_uk

*2	Word files will be automatically converted into RTF files during 
transfer only if Microsoft Word is installed on your computer.

For details on content files you can import, refer to the 
eBook Library Help.

25
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Importing content files

You can select content files stored on your computer and 
import them into Library.

	 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

	 Click “Import Files” on the “File” menu.
The “Import Files” dialog box appears.

	 Click  of the “Look in” list to select the folder 
containing the content file(s) to be imported, as 
necessary.
The content files in the selected folder are listed.

	 Hint
•	 You can also double-click the folder (in the folder list) to display 

the content files in the folder.

	 Select the content file to be imported.
To select multiple files, click the files while holding down 
the Ctrl key.

	 Click “Open.”
The content file(s) is imported into Library.

Hint
•	 You can import all the content files in a selected folder at the same 

time into Library from “Import Folder” on the “File” menu.

26
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Transferring Content

Transferring Content to Reader 
Connected with Your Computer
You can transfer (copy) the content in the Library to the 
Reader.
You can also transfer downloaded content to the Reader 
using Adobe Digital Editions.
For details about usage or support of Adobe Digital Editions, 
refer to the Adobe information page at the following web site:
http://www.adobe.com/go/digitaleditions_uk.

Note

•	 If the Reader is locked, it will not be recognized on your computer 
and content cannot be transferred. (  page 67) If you connect the 
Reader to your computer, disconnect it and unlock the Reader by 
inputting the password.

Hints
•	 The book content can be grouped in the Library as a collection, 

which can be transferred to the Reader. For details on how to 
create or transfer a collection, refer to the eBook Library Help.

•	 You can synchronize content in Library of eBook Library with the 
Reader by specifying a folder (such as “Library” or the sub-items 
under “Library”). (  page 34) The Reader can be automatically 
updated to match the content in Library, when you connect it to 
your computer.

	 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

Continued 27
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	 Connect the Reader to your computer using the 
supplied USB cable.

USB cable  
(supplied)

To USB connector

“Reader” appears in the Source view of eBook Library.
A screen appears on the Reader, indicating that it is 
connected to the computer.
Notes

•	 If “Reader” does not appear in the Source view after connecting 
the Reader to your computer, disconnect the USB cable from 
the Reader, then reconnect it after a while.

•	 When you connect the Reader to your computer,  
(indicating connection via USB) is displayed on the Reader’s 
screen. If the battery has been fully depleted, it takes about 40 
minutes until  is displayed, and you will not be able to turn 
on the Reader by the POWER switch during this time. In this 
case, wait until  is displayed. The indicator lights up in red 
while  is not displayed, and the Reader is charged.

Continued 28
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	 Click “Library” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in the Library is listed.

	 Hints
•	 When you click “Books,” “Audio” or “Pictures” in the Source view, 

only their respective content is displayed.
•	 When you click  (Thumbnail view), content can be displayed as 

thumbnails.
•	 You can create a collection in the Library and the collection can 

be transferred to the Reader. For details on how to create or 
transfer a collection, refer to the eBook Library Help.

	 Select the content you want to transfer from the list.
To select multiple content, click the content while 
holding down the Ctrl key.

	 Drag the content from the list to “Reader” in the 
Source view.
The content is transferred to the Reader.

Reader

Continued 29
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Hint
•	 You can store computer data into the built-in flash memory of the 

Reader by transferring the data from your computer using Windows 
Explorer.

Notes

•	 If there is not enough free space on the memory of the Reader, 
content may not be transferable. The memory of the Reader can be 
increased in the following 2 ways.
	Transfer any unnecessary content back to eBook Library, then 

delete it to increase free space on the Reader. (  page 32)
	Delete any unnecessary book on the Reader.  (  page 54)

•	 Do not delete files in the folder under “database,” and files in 
“database,” using Windows Explorer. Perform data management 
using eBook Library. For details on the eBook Library operations, 
refer to the eBook Library Help.

Transferring content via a memory card
Content imported to eBook Library can be transferred to a 
memory card on the Reader.

Hints
•	 “Memory Stick Duo” and SD Memory Card can be used.
•	 You can synchronize content in Library of eBook Library with a 

memory card on the Reader by specifying a folder (such as 
“Library” or the sub-items under “Library”). (  page 34) For details 
on how to synchronize content with a memory card, refer to the 
eBook Library Help.

	 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

	 Connect the Reader to your computer using the 
supplied USB cable. (  page 28)
“Reader” appears in the Source view of eBook Library.

Continued 30
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	 Insert a memory card into the Media slot of the 
Reader. (  page 20)
“Memory Stick/SD Card on Reader” appears in the 
Source view.

	 Click “Library” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in Library is listed.

	 Hints
•	 When you click “Books,” “Audio” or “Pictures” in the Source view, 

only their respective content is displayed.
•	 When you click  (Thumbnail view), contents can be displayed as 

thumbnails.
•	 You can create a collection in Library and the collection can be 

transferred to a memory card on the Reader. For details on how to 
create or transfer a collection, refer to the eBook Library Help.

	 Select the content you want to transfer from the list.
To select multiple content, click the content while 
holding down the Ctrl key.

	 Drag the content from the list to “Memory Stick/SD 
Card on Reader” in the Source view.
The content is transferred to the memory card on the 
Reader.

Continued 31



PRS-505.GB.3-277-508-11(1)

Hint
•	 You can store computer data into the memory card on the Reader 

by transferring the data from your computer using Windows 
Explorer.

Notes

•	 If there is not enough free space on the memory card, content may 
not be transferable. The memory of the memory card can be 
increased in the following two ways.
	Transfer any unnecessary content back to eBook Library, then 

delete it to increase free space on the memory card. (  page 32)
	Delete any unnecessary book on the Reader. (  page 54)

•	 Do not delete files in the folder under “Sony Reader,” and files in 
“Sony Reader,” using Windows Explorer. Perform data 
management on eBook Library. For details on eBook Library 
operations, refer to the eBook Library Help.

To transfer content back to eBook Library

	 Click the Start menu, then select “All Programs” - 
“Reader” - “eBook Library” to start eBook Library.

	 Connect the Reader to your computer using the 
supplied USB cable. (  page 28)
“Reader” appears in the Source view.

Continued 32
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	 Click “Reader” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in Library is listed.

	 Hints
•	 When you click “Books,” “Audio” or “Pictures” in the Source view, 

only their respective content is displayed.
•	 When you click  (Thumbnail view), contents can be displayed as 

thumbnails.
•	 You can create a collection in the Reader and a memory card on 

the Reader, and the collection can be transferred to eBook 
Library. For details on how to create or transfer a collection, refer 
to the eBook Library Help.

	 Select the content you want to transfer back from 
the list.
To select multiple content, click the content while 
holding down the Ctrl key.

	 Drag the content from the list to “Library” in the 
Source view.
The content is transferred back to eBook Library.
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Synchronizing content in Library with Reader

You can synchronize content in the Library of eBook Library 
with the Reader by specifying a folder (such as “Library” or 
the sub-items under “Library”). The Reader can be 
automatically updated to match the content in the Library, 
when you connect it to your computer.

Note

•	 To synchronize content in the Library of eBook Library with the 
Reader, you need to specify a folder (such as “Library” or the sub-
items under “Library”). For details on how to specify a folder, refer 
to the eBook Library Help.

Hint
•	 When you want to synchronize content in the Library with the 

Reader right away, you can also synchronize them manually. For 
details on how to synchronize content manually, refer to the eBook 
Library Help.

	 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

	 Connect the Reader to your computer using the 
supplied USB cable. (  page 28)
eBook Library starts synchronizing content in the 
Library with the Reader automatically.
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Hints
•	 eBook Library also starts synchronizing content in Library with the 

Reader automatically in the following situations:
	When you start eBook Library after connecting the Reader to 

your computer.
	After a period of time when any changes have been made to the 

specified folder.
•	 You can also synchronize content in the Library of eBook Library 

with a memory card on the Reader. For details on how to 
synchronize content with a memory card, refer to the eBook 
Library Help.

•	 You can also synchronize content in the computer drive with the 
Reader by specifying a folder as a favorite folder. For details, refer 
to the eBook Library Help.
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Reading/Playing/Viewing Content

Reading Books
Reading books transferred from your computer

Follow the steps below to read books transferred from your 
computer.

	 In the Home menu, press / to select “Books by 
Title,” then press Enter.
The Book list appears.
If the contents of the book on the Reader and the 
memory card exceed 30 items, the Index menu appears. 
The Book list can be further sorted by selecting the 
category item in the Index menu. (  page 46) 

Indicates that 
content is 
stored on a 
memory card.

:	“Memory 
Stick Duo”

:	SD Memory 
Card

Number tabs

 indicator
Indicates the number of days remaining before 
the expiration date of the book. If the book has 
already expired, “Expired” is displayed in place of 
the days.
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	 Hints
•	 The content on the memory card also appears in the Book list.
•	 In addition to /, you can also select an item by pressing the 

same number button as indicated on the number tab.
•	 To display the rest of the list, press > (repeatedly).
•	 You can jump directly to the last displayed page by selecting 

“Continue Reading” from the Home menu, without displaying the 
Book list. 

•	 If an invalid operation is performed,  appears at the bottom of 
the screen.

•	 If a book has an expiration date, the number of days remaining 
before expiration is displayed in the Book list. 

	 Press / to select the desired book from the list, 
then press Enter.
The Option menu appears. (  page 38)

	 Press / to select how to open the book, then 
press Enter.
To read the book from the beginning, press / to 
select “Begin,” then press Enter.
The first page of the book appears.

To open the book’s table of contents, press / to 
select “Table of Contents,” then press Enter.
The table of contents appears (if contained in the book 
file).

Press MENU to close the book.

Note

•	 When you select “Table of Contents” of a PDF file, the bookmarks 
contained in the PDF file appear. 
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About the Option menu
The book title is displayed.

To open the last displayed page.
To open the first page of the book.
To open the final page of the book.
To open the Bookmark list. (  page 51)
To open the table of contents of the 
book or the bookmarks of the PDF file, 
if contained in the book/PDF file. 
To open the list of previously displayed 
pages. (  page 53)

To remove all bookmarks, clear history or 
delete book. (  page 52, 53, 54)

To display the book information. (  page 45)
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Book types supported by the Reader

The following are the book types supported by the Reader 
and their characteristics.

eBook
(.lrf and .lrx file 
extension)

A file in BBeB format used in digital books 
and publications.
The link tool embedded in eBooks (page 
jumps, etc.) can be used. (  page 41)

PDF file*1

(.pdf file 
extension)

A File in PDF format (Version 1.4 or before)
Bookmark and link tool on PDF files can 
be used.

EPUB file*1

(.epub file 
extension)

A file in EPUB format used in reflowable 
digital books and publications.

Text file
(.txt file extension)

RTF file 
(rtf. file extension)

An RTF file (unsecured) that is 
automatically converted from a Microsoft 
Word file.*2

*1	Adobe DRM protected PDF and EPUB files supported only if 
Adobe Digital Editions 1.5 or later is installed and authorized on 
your computer. 

*2	Only if Microsoft Word is installed on your computer.
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Operations on the Book page screen
On the Book page screen, the following operations can be 
performed.

Size indicator
Current page number/
total page number

Button Operation

> button To proceed to the next page (press); 
jump 10 pages ahead of the current page 
(press and hold).

< button To return to the previous page (press); 
jump 10 pages back from the current page 
(press and hold).

Number 
buttons

To jump to the selected page (press) (  page 
43);
Jump to the final page (press and hold 0); jump 
to the first page (press and hold 1); jump to any 
other page corresponding to the button 
number(s) (press and hold 2 -9).
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Button Operation

 (size) 
button

To zoom in/out a page.
Every time you press  (size), the page is 
magnified in steps and returns to the original 
scale after the maximum magnification.
•	 The scale switches in 3 steps ( , ,  – indicated 

at the bottom of the screen).
•	 By pressing and holding  (size) for a few 

seconds, screen orientation can be switched 
(vertically/horizontally). (  page 44)

 (MARK) 
button

To create/remove a bookmark on the current 
page (press) (  page 50); 
Jump to the All Bookmark screen (press and 
hold). (  page 52)

MENU button To close the page and return to the Option menu.

To use the link tool of eBooks files on the 
Reader
When an eBook file is displayed, you can use the embedded 
link tool.
The link appears highlighted on the screen. Press Enter to 
open the linked content or jump to the linked page.

Press / to select the desired link, 
and press / to return to the 
previously displayed page.

Link
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About screen view of a magnified page
If you zoom in on a Book page by pressing  (size), the 
characters on the page are magnified. The text is reflowed in 
the Book page screen, and the original page is divided into 
multiple divided sections. To display the next section, press >.

S M L

Notes

•	 If the Book page is magnified, the total page number displayed on 
the Reader increases with the number of divided page sections. 
However, if the Book page of a PDF or EPUB file is magnified, the 
total page number is not increased, and the current page number 
is displayed using the same page number as the original scale.

•	 PDF files viewed in Medium and Large sizes are displayed in 
reflow mode. In certain situations, only text appears in these scales 
as some tables and graphics may be reformatted and altered (the 
same applies to Adobe Reader’s Reflow view). In these cases, 
viewing in Small size will retain the original formatting.
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Jumping to the specified number page 
directly

You can jump directly to a page by inputting the page 
number with the number buttons.

	 On the Book page screen, press the number buttons 
to input the page number.
The input page number appears in the center of the 
page.

To clear the input page number, press .

	 Press Enter. 
The page of the input page number appears.

Hint
•	 By pressing MENU, the previous screen appears. You can input 

the page number again.
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Switching screen orientation (vertical/
horizontal)

Screen orientation (including menu screens) can be 
switched in the following 2 ways.
•	 Press and hold  (size) on a menu screen or a Book page screen.
	 Press and hold  (size) again to switch back.
•	 Configure the setting from the Setting menu. (  page 62)

About screen division when screen orientation 
is set to horizontal
When set to horizontal, the Book page is divided into 2 parts 
(upper and lower). To display the lower part, press >.

>

<

Displaying 
upper half

Displaying 
lower half

Position 
indicator

44



PRS-505.GB.3-277-508-11(1)

Displaying the book information

You can display the book information, such as the title, 
author, book cover thumbnail, etc.

	 In the Option menu, press / to select “Info,” then 
press Enter.
The book information appears.

Options Description

Book cover 
thumbnail*1

Displays the book cover thumbnail.

Title Displays the title.
Author Displays the author.
Publisher*1 Displays the publisher.
Category*1 Displays the category.
eBook ID*1 Displays the Book ID.
Kind Displays the file type.
Date Displays the latest update and creation date.
Size Displays the file size.
Location Displays the memory location where the book is stored.

Internal memory: The book is stored on the Reader.
Memory Stick/ SD Memory Card: The book is 
stored on a memory card.

File Displays the file path location.
Digital 
Rights*1,*2

Displays the following only if the book with DRM is 
selected.
Full viewable: The entire book can be read.
Restricted: Some or all of the book cannot be read.

Expiration 
date*2

Displays the expiration date of the book if the 
book with DRM has an expiration date.

*1	This option is displayed only when BBeB book is selected.
*2	This option is displayed only when PDF and EPUB files are selected.
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Sorting the Book list

On the Book list of “Books by Title”, books are sorted by title 
alphabetically. You can also sort books by author or date. 
If the contents of the book on the Reader and the memory 
card exceed 30 items, the Index menu appears. The Book 
list can be further sorted by selecting the category item in 
the Index menu.

	 In the Home menu, press / to select “Books by 
Title,” “Books by Author” or “Books by Date,” then 
press Enter.
The Index menu appears. (  page 48)
The Index menu does not appear if the contents of the 
book on the Reader and the memory card is less than 
30 items. In this case, press < to display the Index 
menu.

	 Hint
•	 If you select “Books by Date,” the category items of the Index 

menu are different from above. (  page 48)
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	 Press / to select how to sort the Book list, then 
press Enter.

	 Press / to select the desired book from the list, 
then press Enter.
The Option menu appears.

	 Press / to select how to open the book, then 
press Enter.
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About the Index menu

Index menu of “Books by Date”Index menu of “Books by Title”  
and “Books by Author”

The number of 
books in the 
category and 
the page 
number in the 
Book list

Categories

When selecting “Books by Title” and “Books by 
Author”
You can select the first character of the book’s title or author. A Book 
list sorted alphabetically by title or author, starting with the selected 
characters, appears.

When selecting “Books by Date”
You can select the date that books are transferred to the Reader and 
the memory card. A Book list sorted by transferred date appears.
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Selecting a book from the Collection list

You can select and read a book from the list of collections 
created on eBook Library.

Hint
•	 For details on how to create or transfer a collection, refer to the 

eBook Library Help.

	 In the Home menu, press / to select “Collections,” 
then press Enter.
The Collection list appears.

	 Press / to select the desired collection from the 
list, then press Enter.
The Book list appears.

	 Select the desired book from the list, then press 
Enter.
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Creating a bookmark on a page

You can create a bookmark on a page you may wish to 
return to.

	 On the Book page screen, press  (MARK) on the 
desired page.
The mark appears in the top right corner of the page.

Bookmark

If you press  (MARK) again, the bookmark will be 
removed.

Note

•	 When creating a bookmark, the Reader records the current page 
and the current page scale. Therefore, even on the same page, if 
the scale is switched and another bookmark created, the 
bookmarks will be stored at their respective scales.
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To open the desired page from the Bookmark list

	 In the Option menu, press / to select 
“Bookmarks,” then press Enter.
The Bookmark list appears.

	 Press / to select the desired page, then press 
Enter.

Hints
•	 Bookmarks can also be created in the eBook Library.
	 The bookmarks created on the Reader or eBook Library will be 

retained when you transfer books between the Reader and eBook 
Library.

	 If you transfer a book to eBook Library from the Reader, the 
bookmarks created on the Reader will be also transferred to eBook 
Library, and vice versa. 
However, if you transfer a book to a location where the same book 
exists, the bookmarks will not be overwritten.

•	 The annotations of a book transferred from Adobe Digital Editions 
1.5 or later are converted into the bookmarks on the Reader.
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To remove all bookmarks in the current book

	 In the Option menu, press / to select “Utilities,” 
then press Enter.

	 Press / to select “Remove All Bookmarks,” then 
press Enter.
All bookmarks in the current book are removed.
Note

•	 Confirm carefully before removing bookmarks.

To select from the list of all bookmarks on the 
Reader

	 In the Home menu, press / to select “All 
Bookmarks,” then press Enter.
The list of all bookmarks on the Reader appears.

	 Press / to select the desired page, then press 
Enter.

Hint
•	 The All Bookmark list can also be displayed by pressing and 

holding  (MARK).
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Reading previously displayed pages

The Reader stores all displayed pages in memory for easy 
recall at any time.

	 On the Book page screen, press .
As you press  repeatedly, previously displayed pages 
appear in reverse order.

To show the displayed page history

	 In the Option menu, press / to select “History,” 
then press Enter.
The History list appears.

Hint
•	 The History list can store the histories up to 100 pages.

To clear History

	 In the Option menu, press / to select “Utilities,” 
then press Enter.

	 Press / to select “Clear History,” then press Enter.
History data of the current book is cleared.
Note

•	 Confirm carefully before clearing History.
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Deleting a book 

You can delete a book on the Reader and the memory 
cards.

	 In the Option menu, press / to select “Utilities,” 
then press Enter.

	 Press / to select “Delete Book,” then press Enter.

	 Press  (MARK) to delete the current book.
The current book is deleted from the Reader or memory 
cards.
Note

•	 Confirm carefully before deleting the book.
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Playing Audio Files
Playing audio files transferred from your 
computer

MP3 and AAC files (unsecured) can be played back on the 
Reader.
You can also read books while listening to an audio file. (  
page 57)
When listening to audio files, connect the optional 
headphones to the headphone jack.

	 In the Home menu, press / to select “Audio,” then 
press Enter.
The Audio list appears.

Indicates that 
content is stored 
on a memory 
card.

:	“Memory 
Stick Duo”

:	SD Memory 
Card

Thumbnails of 
pictures (if 
contained on files)

Number tabs

 indicator

	 Hints
•	 The content on the memory card also appears in the Audio list.
•	 In addition to /, you can also select an item by pressing the 

same number button as indicated on the number tab.
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•	 To display the rest of the list, press > (repeatedly).
•	 If an invalid operation is performed,  appears at the bottom of 

the screen.
•	 If an audio file is played, “Now Playing” can be selected on the 

Home menu and the Playback screen can be displayed.
•	 The Now Playing icon in the Home menu changes when an audio 

file is being played.

	 Press / to select the desired track from the list, 
then press Enter.
Playback starts.
Tracks are played in alphabetical order.

To stop playback, press Enter.

Operations on the Playback screen
On the Playback screen, the following operations can be 
performed.

Playback indicator

Picture area

Track name
Artist name

Album name
Elapsed playback 
time

Volume indicator

Total time of the 
current track

Current track 
number/total 
track number

Status bar
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Button Operation

> button To skip to the next track.
< button To skip to the previous track.

/ To rewind/fast-forward the track.

Enter button To stop/restart playing the track.

VOLUME +/– 
buttons

To adjust the volume.

Reading books while playing an audio file

You can read books while listening to an audio file.

	 In the Home menu, press / to select “Audio,” then 
press Enter.
The Audio list appears.

	 Press / to select the desired track from the list, 
then press Enter.
Playback starts.

	 Press MENU 2 times to return to the Home menu.

	 Press / to select “Books by Title,” then press Enter.
The Book list appears.

	 Press / to select the desired book from the list, 
then press Enter.
The Option menu appears.
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	 Press / to select how to open the book, then 
press Enter.
The Book page screen appears.
While an audio file is played, the volume indicator  
appears at the bottom of the screen.

Hint
•	 To stop playback, press MENU 3 times to return to the Home 

menu, select “Now Playing” using / and Enter, then press Enter 
on the Playback screen.
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Viewing Pictures
Viewing pictures transferred from your computer

BMP/JPEG/GIF/PNG files can be viewed on the Reader.

	 In the Home menu, press / to select “Pictures,” 
then press Enter.
The Picture list appears.

Indicates that 
content is stored 
on a memory 
card.

:	“Memory 
Stick Duo”

:	SD Memory 
Card

Thumbnails

Number tabs

 indicator

	 Hints
•	 The content on the memory card also appears in the Picture list.
•	 In addition to /, you can also select an item by pressing the 

same number button as indicated on the number tab.
•	 To display the rest of the list, press > (repeatedly).
•	 If an invalid operation is performed,  appears at the bottom of 

the screen.
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	 Press / to select the desired picture from the list, 
then press Enter.
The Picture appears.

Operations on the Picture viewer
On the Picture viewer, the following operations can be 
performed.

Current picture number/
total picture number

Size indicator

Button Operation

> button To display the next picture.

< button To display the previous picture.

 (size) button To zoom in/out a page.
Every time you press  (size), the picture is 
magnified in steps and returns to the original 
scale after the maximum magnification.
The scale switches in 3 steps ( , ,  – 
indicated at the bottom of the screen).

Enter button To restore the original scale when the picture 
is magnified.
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To scroll the magnified picture
If you zoom in the picture by pressing  (size), / / /  
appear at the edges of the screen.
Press /// to scroll the screen.

To view a slideshow of pictures
You can view a slideshow of pictures.
With the slideshow set to on, select the desired picture with 
which to start the slideshow from the Picture list.
The slideshow setting can be configured from the Setting 
menu. (  page 64)
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Settings

Setting screen orientation
Screen orientation (including menu screens) can be set to 
vertical/horizontal.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Orientation,” then press Enter.
The orientation is switched from vertical to horizontal.
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Setting the Date and Time
You can set the date and time displayed on the Reader.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Date and Time,” then press Enter.

	 Press / to select “Year,” “Month,” “Date,” “Hour,” 
and “Minute,” then press the number buttons to 
input the date and time.

	 Press / to select “OK,” then press Enter.

Hint
•	 When you connect the Reader to your computer with eBook 

Library started, the date and time of the Reader is automatically 
synchronized with your computer clock.
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Setting the Slideshow
Follow the steps below to configure the slideshow settings.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Slideshow,” then press Enter.
The Slideshow setting screen appears.

	 Press Enter repeatedly to select “Off” or “On.”
The setting switches from “Off” to “On,” and the 
slideshow setting is activated.

	 Press // to select “Slide Duration,” then press 
the number buttons to input the duration time.
“Slide Duration” can be set up to 60 seconds in 1 
second increments.

	 Press /// to select “OK,” then press Enter.

Notes

•	 The default setting of Slideshow is “Off.”
•	 When a large size picture is displayed, it may take longer to display 

the picture than the indicated setting time on “Slide Duration.”
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Setting the Sleep Mode (Resume 
Function)
You can set the Reader to automatically enter sleep mode. 
In sleep mode, the Reader automatically turns off if no 
operation is performed for 60 minutes (resume function).

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Sleep Mode,” then press Enter.
The Sleep Mode setting screen appears.

	 Press Enter repeatedly to select “Off,” or “On.”
Off: The Reader does not go into sleep mode.
On: The Reader automatically enter sleep mode.

	 Press / to select “OK,” then press Enter.
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Notes

•	 The default setting of Sleep Mode is “On.”
•	 In the following states, the Reader does not automatically turn off if 

no operation is performed for 60 minutes.
–	When connecting the computer using the supplied USB cable
–	When connecting the AC Adaptor for Reader (AC-S5220E) 

(optional) to charge
–	When playing audio files

Hint
•	 To reduce the power consumption, the Reader provides the 

following two modes. 
–	Sleep Mode:
	 Reader can be set to automatically enter Sleep Mode after a 

period of inactivity. Once in Sleep Mode, the Reader goes into a 
power savings mode and prevents any unintended keypad input. 
To turn Reader on again, slide the POWER switch and Reader 
will immediately resume to show the previously displayed screen.

–	Device Shutdown: 
	 Reader can be set to enter Device Shutdown mode. Once in 

Device Shutdown Mode, the Reader will no longer consume 
power and conserve it’s battery for an extended period of time. To 
turn Reader on again, slide the Power switch, and the start-up 
screen will appear in a few moments. (  page 70)
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Setting the Advanced Settings
You can lock the Reader, format the built-in flash memory, 
and shut down the Reader.

Locking the Reader

You can lock the Reader by setting a password.
Follow the steps below.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Advanced Settings,” then press 
Enter.
The Advanced Settings menu appears.

	 Press / to select “Device Lock,” then press Enter.
The Device Lock setting screen appears.

	 Press Enter repeatedly to select “Off” or “On.”
The setting switches from “Off” to “On,” and the Device 
Lock setting is activated.

Note

•	 If the Device Lock is activated, the Reader is not recognized on 
your computer and the content cannot be transferred. 
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	 Press // to select “Code,” then press the 
number buttons to input the password.
The 4-digit password is set.

	 Press /// to select “OK,” then press Enter.

Once the password is set, next time you turn on the Reader, 
the screen asking for the password appears. 
Press the number buttons to input the password, press  to 
select “OK,” then press Enter. 

Note

•	 Be careful not to forget the password.
	 If you lost your password, please call Sony Support Center.
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Formatting the internal memory

You can format the built-in flash memory of the Reader. If 
the memory is formatted, all content will be erased.

Note

•	 Be sure to verify the content in memory prior to formatting and 
transfer any necessary content to the hard disk of your computer or 
other device.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Advanced Settings,” then press 
Enter.
The Advanced Settings menu appears.

	 Press / to select “Format Internal Memory,” then 
press Enter.

	 Press  (MARK) to format the built-in flash memory 
of the Reader.
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Shutting down Reader

If you will not be using the Reader for several days, the 
power consumption of the battery can be minimized by 
shutting down the Reader.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Advanced Settings,” then press 
Enter.
The Advanced Settings menu appears.

	 Press / to select “Device Shutdown,” then press 
Enter.

	 Press  (MARK) to shut down the Reader.

Notes

•	 When turning on by sliding the POWER switch from this state, the 
Reader may take a few moments to turn on.

•	 When you connect the Reader to your computer after shutting 
down, it is necessary to turn on the Reader again. Otherwise, it 
takes about 40 minutes until  (indicating connection via USB) is 
displayed, and you will not be able to turn on the Reader by the 
POWER switch during this time. The indicator lights up in red while 

 is not displayed, and the Reader is charged.  In this case, 
disconnect the USB cable from the Reader, then turn on the 
Reader and reconnect it.
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Checking Version Information for 
Reader
The product name and the firmware version of the Reader 
can be displayed.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “About,” then press Enter.
The About screen appears.

71



PRS-505.GB.3-277-508-11(1)

Troubleshooting

Troubleshooting
If the Reader does not function as expected, try the 
following steps to resolve the issue.

	 Reset the Reader by pressing the Reset button with 
a small pin or clip.
The content and settings stored on the Reader are not 
affected by resetting, and no information is erased.
After pressing the Reset button, turn on the Reader by 
sliding the POWER switch.

Note

•	 When you connect the Reader to your computer after a reset, it is 
necessary to turn on the Reader again. Otherwise, it takes about 
40 minutes until  (indicating connection via USB) is displayed, 
and you will not be able to  turn on the Reader by the POWER 
switch during this time. The indicator lights up in red while  is 
not displayed, and the Reader is charged.  In this case, 
disconnect the USB cable from the Reader, then turn on the 

	 Reader and reconnect it.

	 Check the symptoms in “Troubleshooting.”
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	 Check for information about the issue in eBook 
Library Help.

	 Look for information about the issue on one of the 
support Web sites.
http://support.sony-europe.com/eBook/PRS

	 If the approaches listed above fail to resolve the 
issue, please call Sony Support Center.

Power
Symptom Cause or corrective action

Battery life seems 
short.

	The operating temperature is below 
5 °C (41 °F). This is due to the 
battery characteristics and not a 
malfunction.

	You have not used the Reader for a 
prolonged period. Efficiency of the 
battery will be improved by 
repeatedly charging and discharging.

	The battery needs to be replaced. 
Consult your nearest Sony Service 
Center.

	The battery has not been given 
enough time to charge fully.

	 Charge the battery until the indicator 
goes off. (The battery icon does not 
indicate remaining battery power 
during charging.)
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Symptom Cause or corrective action

The Reader cannot 
be turned on.

	Moisture condensation may have 
occurred. Wait for a few hours and 
then turn on the Reader.

	If the battery has been fully depleted, 
connect to your computer via USB 
and charge the battery. (  page 17) 
If the battery has fully been depleted, 
it takes about 40 minutes until  
(indicating connection via USB) is 
displayed, and you will not be able to  
turn on the Reader by the POWER 
switch during this time. In this case, 
wait until  is displayed. The 
indicator lights up in red while  is 
not displayed, and the Reader is 
charged.

Screen
Symptom Cause or corrective action

It takes time for the 
display to appear.

	In a cold place such as outdoors, it 
may take time for the display to 
appear.

	 This is due to the display 
characteristics and not a malfunction.

Continued

Power (continued)
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Reading/playing/viewing contents
Symptom Cause or corrective action

A book cannot be 
read.

	A book with copyright protection 
cannot be read on any device other 
than the authorized one.

	If the book has an expiration date, 
confirm whether the book has 
already expired.  page 36.

An audio file cannot 
be played back.

	Audio files that are not supported by 
the Reader cannot be played. For 
details on supported audio files, refer 
to  page 55.

Sound is not output. 	Raise the volume if it is set low.
	If sound is not output through 

headphones, make sure the 
headphone plug is firmly inserted in 
the headphone jack.

A picture cannot be 
displayed.

	Picture files that are not supported 
by the Reader cannot be viewed. For 
details on supported picture files, 
refer to  page 59.

	A picture of large size may not be 
displayable, and its file will not appear 
in the list. Delete the picture file using 
eBook Library.

The data on 
Continue Reading, 
Bookmark or History 
of some files is 
missing.

	If the file status has changed (such 
as in the following cases), the data 
on Continue Reading, Bookmark or 
History may be deleted.
•	 A Text/RTF/PDF file is edited.
•	 An eBook purchased with an authorized 

Reader is read on another de-authorized 
Reader by memory card transfer.

Continued 75



PRS-505.GB.3-277-508-11(1)

Connection to the computer
Symptom Cause or corrective action

The Reader cannot 
be operated during 
USB connection.

	The Reader cannot be operated 
while it is connected to a computer.

The Reader cannot 
be recognized.

	Is the power of the Reader turned on? Is 
the USB cable connected properly?

	 Verify the above and try again.
	Are you using a USB hub or USB 

extension cable?
	 Connecting the Reader via a USB 

hub or extension cable may not work 
and is not supported. Connect the 
USB cable directly to the computer.

	Verify that  (indicating connection 
via USB) is displayed at the top of 
the Reader’s screen. If the Reader 
still cannot be recognized, 
disconnect the USB cable from the 
Reader, then reconnect it after a 
while.

	If “Device Lock” of the Reader is set 
to “On,” set it to “Off.” If the Reader is 
locked, it will not be recognized on 
your computer.
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Symptom Cause or corrective action

Content cannot be 
transferred to the 
Reader from your 
computer.

	The USB cable is not connected 
properly. Disconnect the USB cable, 
then reconnect it.

	There is not enough free space on 
the Readers memory. Transfer any 
unnecessary content back to eBook 
Library, then delete it to increase free 
space on the Reader.

There is no response 
from eBook Library 
during 
communication with 
the Reader.

	Disconnect the USB cable from the 
Reader, then reconnect it.

The Reader 
becomes unstable 
while it is connected 
to the computer.

	Are you using a USB hub or USB 
extension cable?

	 Connecting the Reader via a USB 
hub or extension cable may not work 
and is not supported. Connect the 
USB cable directly to the computer.

The Reader’s battery 
cannot be charged. 
(The indicator does 
not light up.)

	Is the USB cable connected 
properly? Verify and try again.

	Are you using a USB hub or USB 
extension cable? Connecting the 
Reader via a USB hub or extension 
cable may not work and is not 
supported. Connect the USB cable 
directly to the computer.

Connection to the computer (continued)
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eBook
Symptom Cause or corrective action

An eBook cannot be 
read.

	You may not have signed up for the 
service or authorized which is 
necessary for reading eBooks. 
Authorize your computer and the 
Reader.

	You may have tried to read the 
content owned by another user. 
The content owned by another 
user cannot be read.

	Installation and authorization of 
Adobe Digital Editions version 1.5 
or later on your computer is 
required for reading Adobe DRM 
protected content. For details 
about usage or support of Adobe 
Digital Editions, refer to the Adobe 
information page at the following 
web site:  
http://www.adobe.com/go/
digitaleditions_uk
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Memory card
Symptom Cause or corrective action

Content on a 
memory card cannot 
be read/played/
viewed.

	Check that the memory card is 
inserted in the Media slot in the 
correct direction.

	Check to see that you are using a 
memory card that is supported by 
the Reader.

	Clean the terminal area of memory 
card gently with a soft cloth if it is 
dirty.

Content cannot be 
transferred to a 
memory card.

	Release the erasure prevention 
switch if it is locked.

	There is not enough free space on 
the memory card. Delete 
unnecessary data.

A memory card 
cannot be 
recognized.

	A memory card which is not 
formatted with FAT may not be able 
to be recognized on eBook Library.

	 When formatting a memory card, 
format it using the formatter supplied 
with the memory card, or using 
Windows Explorer by specifying FAT.
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Restoring default settings

All default settings of the Reader can be restored.

Notes

The following occurs when you restore the default settings.
•	 The screen orientation setting will be vertical.
•	 The password will be erased and the device lock released.
•	 The Slideshow setting will be set to “Off” and its duration time set 

to 5 seconds.
•	 The volume will return to the default level.

	 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

	 Press / to select “Restore Defaults,” then press 
Enter.
The Restore Defaults screen appears. 
If “Device Lock” (  page 67) is set to “On,” the screen 
asking for the password appears. Input the password, 
then select “OK.”

	 Press  (MARK) to restore default settings.
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Uninstalling eBook Library
To uninstall the supplied software from your computer, follow 
the procedures below.

Note

•	 Before uninstalling, de-authorize your computer if it is authorized.
	 For details on de-authorization, refer to the eBook Library Help.

	 Click “Start” – “Control Panel.”

	 Double-click “Add/Remove Programs.” *1

	 Click “eBook Library by Sony” in the “Currently 
Installed Programs” list, then click “Remove.” *2

Follow the on-screen instructions and restart your 
computer. The uninstallation is complete when the 
computer has restarted.

Uninstalling PRS-505 User’s Guide
1	 Click “Start”-“Control Panel.”

2	 Double-click “Add/Remove Programs.” *1

3	 Click “PRS-505 User’s Guide” in the “Currently Installed 
Programs” list, then click “Remove.” *2

Follow the on-screen instructions and restart your computer. The 
uninstallation is complete when the computer has restarted.

*1	 “Uninstall a program” or “Programs and Features” in the case of 
Windows Vista.

*2	 “Uninstall” in the case of Windows Vista.
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Other Information

Updating the Reader’s Firmware
By updating the Reader’s firmware, you can ensure your 
Reader has the latest features. The latest firmware updates 
can be performed from the update menu on eBook Library 
from “Help” – “Check for Updates.”
For details on updates, refer to the eBook Library Help or 
the following website.
http://support.sony-europe.com/eBook/PRS
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About Books Pre-installed on 
Reader
The Reader is pre-installed with sample data so that you 
can try it out right away. The pre-installed sample data is for 
the purpose of trial reading, viewing and listening.

About sample data
The Reader is pre-installed with sample data.
If you delete the sample data, you cannot restore it, and we 
will not supply any replacement data.
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Notes on Reader Disposal
The built-in rechargeable battery of the Reader is recyclable. 
Do not remove the battery yourself, consult Sony Support 
Center.
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Precautions
Disposal of Old Electrical & Electronic Equipment 
(Applicable in the European Union and other European 
countries with separate collection systems)

This symbol on the product or on its packaging indicates 
that this product shall not be treated as household 
waste. Instead it shall be handed over to the applicable 
collection point for the recycling of electrical and 

electronic equipment. By ensuring this product is disposed of 
correctly, you will help prevent potential negative consequences 
for the environment and human health, which could otherwise 
be caused by inappropriate waste handling of this product. The 
recycling of materials will help to conserve natural resources. 
For more detailed information about recycling of this product, 
please contact your local Civic Office, your household waste 
disposal service or the shop where you purchased the product.
Applicable accessories: Headphones

Disposal of waste batteries (applicable in the 
European Union and other European countries 
with separate collection systems)

This symbol on the battery or on the packaging 
indicates that the battery provided with this product 
shall not be treated as household waste.

By ensuring these batteries are disposed of correctly, you 
will help prevent potentially negative consequences for the 
environment and human health which could otherwise be 
caused by inappropriate waste handling of the battery. The 
recycling of the materials will help to conserve natural 
resources.
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In case of products that for safety, performance or data 
integrity reasons require a permanent connection with an 
incorporated battery, this battery should be replaced by 
qualified service staff only.
To ensure that the battery will be treated properly, hand over 
the product at end-of-life to the applicable collection point for 
the recycling of electrical and electronic equipment.

For all other batteries, please view the section on how to 
remove the battery from the product safely. Hand the battery 
over to the applicable collection point for the recycling of 
waste batteries.

For more detailed information about recycling of this product 
or battery, please contact your local Civic Office, your 
household waste disposal service or the shop where you 
purchased the product.

Notice for customers: the following 
information is only applicable to equipment 
sold in countries applying EU Directive
The manufacturer of this product is Sony Corporation, 1-7-1 
Konan, Minato-ku, Tokyo, Japan. The Authorized 
Representative for EMC and product safety is Sony 
Deutschland GmbH, Hedelfinger Strasse 61, 70327 
Stuttgart, Germany.
For any service or guarantee matters please refer to the 
addresses given in separate service or guarantee 
documents.
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On safety

•	Do not insert any foreign objects in the DC IN jack of the 
Reader.

•	Be sure not to short-circuit the terminals of the Reader 
with metallic objects.

On installation

•	Never subject the Reader to extremes of light, 
temperature, moisture or vibration.

•	Never wrap the Reader in anything when it is being used 
with the AC power adapter. Heat build-up in the Reader 
may cause malfunction or damage.

Continued 87

http://www.rbrc.org/


PRS-505.GB.3-277-508-11(1)

On heat build-up

Heat may build up in the Reader while charging, or if it is 
used for an extended period of time.

On the headphones

Road safety
Do not use headphones while driving, cycling, or operating 
any motorized vehicle. It may create a traffic hazard and is 
illegal in many areas. It can also be potentially dangerous to 
play at a high volume while walking, especially at pedestrian 
crossings. You should exercise extreme caution or 
discontinue use in potentially hazardous situations.

Preventing hearing damage
Avoid using the headphones at a high volume. Hearing 
experts advise against continuous, loud and extended play. 
If you experience a ringing in your ears, reduce the volume 
or discontinue use.

Caring for others
Keep the volume at a moderate level. This will allow you to 
hear outside sounds and to be considerate to the people 
around you.

Warning
If lightning occurs while you are using the Reader, take off 
the headphones immediately.
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Notes on memory cards

About “Memory Stick Duo”
“Memory Stick Duo” is a high-capacity compact IC recording 
media. Not only can you exchange data among “Memory 
Stick Duo” compatible devices, but also you can use as an 
external removable data storage.

About SD Memory Card
SD Memory Card complies with compact memory card 
standard and is commonly used as a storage media for 
digital still cameras.

For details on memory cards supported by the Reader, refer 
to “Inserting a Memory Card” on  page 19.

Notes on handling memory cards
•	When using miniSD Card on the Reader, an adaptor (sold 

separately) is required.
•	The Reader does not comply with the following:

−	MagicGate standard.
−	copyright protection of SD Memory Cards.
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•	You cannot record or delete data stored in a memory card 
when its erasure prevention switch is locked.

	

•	Keep a memory card in its case when you carry or store it.
•	Do not touch the connector of a memory card with bear 

hands or metallic objects.
•	Do not bend, drop, or subject a memory card to excessive 

shock.
•	Do not disassemble or modify a memory card.
•	Do not allow a memory card to get wet.
•	Avoid the following to prevent data damage. Sony does not 

provide any guarantee for damaged data.
−	Remove a memory card or turn off the Reader while reading or 

writing data.
−	Operate the Reader in the location where static charge or 

electrical noise is present.

•	Do not use a label other than the dedicated one in the 
label area.

•	Do not use or store the Reader in a location subject:
−	extreme high temperature, such as in a sun-heated car.
−	direct sunlight.
−	high humidity or places with corrosive substances.
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On software

•	Copyright laws prohibit reproducing the software or the 
manual accompanying it in whole or in part, or renting the 
software without the permission of the copyright holder.

•	In no event will SONY be liable for any financial damage, 
or loss of profits, including claims made by third parties, 
arising out of the use of the software supplied with this 
Reader.

•	In the event a problem occurring with this software as a 
result of defective manufacturing, SONY will replace it. 
However, SONY bears no other responsibility.

•	The software provided with this Reader cannot be used 
with equipment other than that which is so designated.

•	Please note that, due to continued efforts to improve quality, 
software specifications may be changed without notice.

•	Operation of this Reader with software other than that 
provided is not covered by the warranty.

•	The ability to display the languages on your eBook Library 
will depend on the OS installed on your computer. For 
better results, please ensure that the installed OS is 
compatible with the desired language you want to display.
−	We do not guarantee all the languages will be able to be 

displayed properly on your eBook Library.
−	User-created characters and some special characters may not 

be displayed.

•	Explanations in this manual assume that you are familiar 
with the basic operations of Windows. For details on the 
use of your computer and operating system, please refer 
to the respective manuals.
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On Cleaning
•	Clean the case of the Reader with a soft cloth, such as a 

cleaning cloth for eyeglasses.
•	If the case of the Reader becomes very dirty, clean it with 

a soft cloth slightly moistened with water or a mild 
detergent solution.

•	Do not use any type of abrasive pad, scouring powder, or 
solvent, such as alcohol or benzene, as it may mar the 
finish of the case.

•	Be careful not to let water get into the Reader from the 
opening near the connector.

•	Clean the headphone plug periodically.

If you have any questions or problems concerning the 
Reader, consult your nearest Sony dealer.

Notes

•	 Recorded content is limited to private use only. Use of the 
content beyond this limit requires permission of the copyright 
holders.

•	 Sony is not responsible for incomplete recording/downloading or 
damaged data due to problems of the Reader or computer.
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On Copyrights

The contents of each book pre-installed on this product 
are copyrighted works, edited with the cooperation of the 
publisher and editor hereto mentioned.
Copyright laws prohibit copying the data of this product or 
the contents of this manual (illustrations, related 
documents, etc.) in whole or in part without the permission 
of the copyright holder. Additionally, use of the data of this 
product or the contents of this manual is not allowed 
without Sony’s permission except for personal use.

•	 SONY and the SONY logo are registered trademarks of Sony 
Corporation.

•	 BBeB, BBeB Book, and their logos are trademarks of Sony 
Corporation.

•	 “Memory Stick,” “Memory Stick Duo,” “Memory Stick PRO Duo,” 
and their logos are trademarks of Sony Corporation.

•	 Bitstream is a registered trademark, and Dutch, Font Fusion, 
and Swiss are trademarks, of Bitstream Inc.

•	 Microsoft, Windows, Windows Vista and Windows Media are 
trademarks or registered trademarks of Microsoft Corporation in 
the United States and / or other countries.

•	 Adobe, the Adobe logo, Reader and PDF are either registered 
trademarks or trademarks of Adobe Systems Incorporated in 
the United States and/or other countries.

•	 MPEG Layer-3 audio coding technology and patents licensed 
from Fraunhofer IIS and Thomson.
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•	 This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit.  	
(<http://www.openssl.org/>)  Copyright © 1998-2006 The 
OpenSSL Project. All rights reserved. This product includes 
cryptographic software written by Eric Young (eay@cryptsoft.
com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com). For details on OpenSSL License, refer to 
“openssl.txt” on the CD-ROM.

All other system names and product names appearing in this 
document are generally the registered trademarks or trademarks 
of their respective manufacturers. Further, the trademark TM and 
registered trademark ® symbols are not indicated throughout this 
document.

Program ©2006, 2007, 2008 Sony Corporation
Documentation ©2006, 2007, 2008 Sony Corporation

About GNU GENERAL PUBLIC LICENSE

Dear customers
Thank you for purchasing this product.
Included with this product is the following software which 
applies to GPL/LGPL. You may obtain, modify and 
redistribute the source codes of the software.

bash
fileutils
findutils
gcc
glib
glibc
grep
hardhatutils
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hostname
mkcramfs
mtd-utils
mtools
ncurses
pam
procps
psmisc
sed
shellutils
sysutils
sysvinit
tar
textutils
time
util-linux

These source codes are available on the web site.
Access the following web site to download.
http://www.sony.net/Products/Linux/
Note that Sony accepts no inquiries concerning the contents 
of these source codes.

For details on GNU GENERAL PUBLIC LICENSE, refer to 
“GPL (English).rtf,” “GPL (French).rtf,” “LGPL (English).rtf” 
and “LGPL (French).rtf” on the CD-ROM.
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Specifications

Model name
PRS-505

Power source
Built-in rechargeable battery: DC 3.7 V
AC power adapter: DC 5.2 V

Battery life (continuous playback)
Approx. 6800 pages with EPUB contents  

(when the battery is fully charged)

User available capacity
Approx. 192MB
Available storage capacity of the Reader may vary.

Operating temperature
5 to 35 °C (41 to 95 °F)

Dimensions (w/h/d)
Approx. 123.0 x 174.3 x 7.8 mm
(maximum, without soft cover)

Mass
Approx. 260 g (without soft cover)

Optional Accessories
AC Adaptor for Reader: AC-S5220E
Cover with Light: PRSA-CL1

Design and specifications are subject to change without 
notice.
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Index
Symbols

 (MARK) button.................10, 50
 (page)......................................9
 (size) button...........................10

< buttons.......................................9
> buttons.......................................9
/// buttons...........................8

A
Adobe Digital Editions 

....................7, 23, 25, 27, 39, 51
Advanced Settings......................67

Device Lock..........................67
Device Shutdown..................70
Format  Internal Memory......69

Audio file.....................................55

B
Battery........................................18
BBeB Book.................................25
Book list................................13, 36
Bookmark...................................50
Books by Author.........................48
Books by Date............................48
Books by Title.................13, 36, 48
Book types..................................39

C
Charging.....................................17	

See also “Quick Start Guide”
Collection....................................49

D
DC IN jack..................................10
Default settings...........................80

E
eBook Library...........23, 25, 27, 30

Help........................................3
Install...See “Quick Start Guide”
Uninstalling...........................81

eBooks..............................7, 23, 39
Enter button..................................8
EPUB file..............................25, 39

H
Headphone jack..........................11
Hole for hand strap.....................10
Holes for soft cover  

attachment..............................10
Home menu................................13
Horizontal.............................44, 62
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I
Import.........................................23

Content.................................25
eBooks..................................23

Index menu...........................46, 48
Indicator........................................9
Information..................................45

L
Link.............................................41

M
Manual..........................................2
Media slot...............................9, 19

“Memory Stick Duo” slot..........9
SD Memory Card slot.............9

Memory Card..............................19
“Memory Stick Duo”..............19, 89
MENU button..........................9, 13

N
NEXT button...............................40
Number button......9, 37, 40, 55, 59
Number tab.....................37, 55, 59

O
Option menu.........................13, 38

P
Picture........................................59
POWER switch.......................9, 15

R
Reading books............................36

while playing an audio file.....57
Reset..........................................72

Reset button....................11, 72
RTF file.................................25, 39

S
SD Memory Card..................19, 89
Setting........................................62

Advanced Settings................67
Date and Time......................63
Orientation............................62
Sleep Mode.....................16, 65
Slideshow..............................64
Version Information...............71

Slideshow.............................61, 64
Sort.............................................46
Synchronizing.............................34

T
Table of contents........................38
Transfer.......................................27
Troubleshooting..........................72
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U
Updating.....................................82
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